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LICENCE AGREEMENT 

The Pocket IQ End User Licence Agreement (EULA) is a legal agreement between 
you and Pocket IQ Limited. By downloading or installing this SOFTWARE, you agree 
to be bound by the terms of this Agreement. If you do not agree to the terms of this 
Agreement, remove this SOFTWARE immediately. 

Pocket IQ END USER LICENCE AGREEMENT (EULA) 

This licence refers to any product which is distributed by Pocket IQ. 

GRANT OF LICENCE 

This Pocket IQ Licence Agreement ("Licence") permits you to use one copy of this 
product, on multiple machines which may include user documentation provided in 
electronic form ("SOFTWARE"), providing it is for the sole, exclusive use of the 
registered user. The SOFTWARE is licensed as a single product. Its component 
parts may not be separated for use on more than one computer or by more than one 
user at any one time. 

COPYRIGHT 

The SOFTWARE (including any images and text incorporated into the product) is 
owned by Pocket IQ and the independent pplication author, or its suppliers and is 
protected by English copyright laws and international treaty provisions. 

REVERSE TRANSLATION 

The SOFTWARE, including all related program files may not be altered in any way. 
Reverse Translation is expressly forbidden without written permission of the Pocket 
IQ and the independent application author. 

LIMITED WARRANTY 

To the maximum extent permitted by applicable law, Pocket IQ and the independent 
application author disclaims all warranties, either express or implied, including but not 
limited to warranties of merchantability and fitness for a particular purpSBe. In no 
event shall Pocket IQ, the independent application author or its suppliers be liable for 
any damages whatsoever (including, without limitation, damages for lSBs of business 
profits, business interruption, lSBs of business information, or other pecuniary lSBs) 
arising out of the use or inability to use this Pocket IQ product. 

The SOFTWARE is supplied 'as is' and no advice or technical support is guaranteed 
from Pocket IQ or any third party.  



 

SmallBase 
 

Introduction 

 

SmallBase is an extended databases manager for EPOC systems. SmallBase runs 
on ER3(Series 5, Geofox), ER5 (Series 5MX, REVO, Series 7, Netbook) and ER6 
(Nokia 9210/9290) based devices. 

SmallBase use the internal EPOC DBMS system in order to store and manage your 
datas. 

But SmallBase offers much more… 

Use SmallBase to create easily specific applications and manage important datas. 

SmallBase offers a high level of customization with data display. 

Users can define color display for datas according in using specific criterias. 

Apply filters on the fly and retrieve quickly datas with an extended search function. 

Encrypt and secure your databases with a single password. Based on a 256-bits 
encryption engine, SmallBase can protect your confidential datas with a high level of 
security. 
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1. Manage Tables and Databases 

SmallBase databases are composed with tables. A table contains fields, users must 
first create this structure before entering datas. 

When started SmallBase, propose to create a new database named SmallBase on 
the main disk. SmallBase will automatically turn to “Build” mode. 

 

Table Fields can have different types. 

SmallBase supports the fields types decribed below. 

Name Type Size Comment Active
Text Char 1-255 max Basic text field N 
Memo Char 1-255 max Multilines text field N 
Numeric Integer 4 bytes  N 
Floating point Decimal 8 bytes  N 
Date Date/Time 8 bytes Single date N 
Duration Integer 4 bytes Duration as 00:00 N 
Date/Time Date/Time 8 bytes Date with time N 
Choice List Char 1-255 max List of user-defined text N 
Long Memo Char Unlimited Multilines text field without 

any size limitation 
N 

Telephone 
number 

Char 1-255 Text field used considered 
by the engine as 
composable 

Y 

Formula Floating point 8 bytes Calculated field according to 
a user-defined arithmetic 
formula which allow fields 
combinaison. 

Y 

File List Char Unlimited Multilines text field which 
contains a list of files 
separated with a “;” char. 

Y 

Folder List Char Unlimited Multilines text field which 
contains a list of folder 
separated with a “;” char. 

Y 
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Calc Floating point 8 bytes Calculated field according to 
a referred field in another 
Table. The calculation can 
be : Sum, Max, Min or 
Average. 

The calculation is based on 
a filter applied on the 
referred table. 

Y 

Yes/No Integer 4 bytes  N 
Variable Char 50 Max This field contains the name 

of a variable (see variables 
chapter). The field may be 
displayed by its name or its 
content. 

This field is useful for 
formulas. Users can define 
different kind of formula 
which may contain variable 
field types. 

 

Y 

 

In “Build” mode, SmallBase proposes table creation (Add), table update (Edit), table 
deletion (Delete) and table duplication (Duplicate). 

The “Esc” key returns to normal mode. 

1.1.Add a new table. 

 

Create a table named “TASKMAN”. This table can be used to track tasks for 
example. 
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Manage fields with SmallBase for the current table. 

SmallBase allows here field creation (Add), field update (Edit), field deletion 
(Delete), and specific operations for Formula and Choice List field types. 
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1.2.Manage fields. 

 

The field management lets a high level of customization. 

Tab Field Comment 
Field Type  General information 
 Label Label of the field display in the columns header 
 Visible Field is visible or not in card view 
 Type Field Type (see before) 
 Size Only for Text-based field (but for memo) 
 Order Position in all views (grid view, card view, entering 

mode). 
 Default User can set a default value to this field. In the 

cases of Variable and Choice List types fields, 
users must create first the field without any default 
value, then set the variables or the choice lists, 
and finally set the default value by editing the field 
again. 

   
Card View  Concern the card view only 
 Label Yes or No (label appears or not in card view) 
 Foreground Foreground color of the displayed data in the card 

view. 
 Font Default or select a specific font to display data 
 Size Size of the font  
 Bold Yes/No 
 Italic Yes/No 
   
Display  Concern the dialog box when editing data 
 Edit Box Width Size of the edit box 
 Lines Number of lines in the dialog box (only for 

multilines field types). 
 Sorted Only for Choice List field types, items are or not 

sorted by alphabetically order. 
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Grid  Concern the grid view 
 Column Size Width in twips of the column (field is not displayed 

in the grid if column size=0). 
 Display Value Only for Variable field type, in this case the value 

of the variable is displayed insteed of the variable 
name. 
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Report  Concern reports 
 Column Size Width of column in number of Chars 

 

For our example we create a Table with those fields 

Field Type Color Comment 
Todo Text/50 Blue What I have to do 
Priority Numeric Black Priority of the todo 
Status Choice List Green Planned, In Progress, Complete 
Due Date Date Red The due date of the todo 
Close Date Black The date when I have complete the todo. 
Who Text/50 Black Who have to work on the todo 
Project Text/50 Magenta The project ref 
Tel Tel Number Black Phone number 
Note Long Memo Black Notes  
Folders Folder List Black Preferred folder (just for example) 
Files File List Black A list of files 
Cost Floating 

Point 
Blue The unit cost of workload 

Hours Integer Black Number of hours spent on this todo 
Total Formula Red Total = Cost*Hours 

 

Press “Cancel” to stop creation loop. 
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1.3.How to manage a choice list ? 

Go on the “Status” field and press “Others” 

 

SmallBase offers the capability to enter choice list strings. 

Users can now Add, Edit or Delete entries in the list. 

 

 

Press “Close” to come back to the main list. 
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1.4.How to set a formula ? 

Select the “Total” Field in List and press “Others” 

 

The formula is composed by a combinaison of values, fields, variables and 
mathematics functions. 

In order to help users to remember what are the available fields for the selected 
table, SmallBase displays the fields and the labels in a choice list. The Functs list is 
also displayed in a choice list to help user with the syntax. 

In our example, we can enter : r13*r14 in the Formula field 

 

The table has now been created. 

Close the dialog box with “Esc” key. 



SmallBase User Manual 

14 

 

SmallBase is now waiting for a Table selection. 

We can select “TASKMAN” in pressing “Enter” key 

 

 “TASKMAN” Table is now displayed. 
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1.5.How to set a Calc field ? 

In order to explain the use of a Calc field, create a new Table called “COSTS” 

This field will contain 2 fields : “Status” (Text) and “Total” (Calc). 

 

Select the “Total” Field in List and press “Others”. 

 

In this case we will set the “Total” field of “COSTS” table equal to the sum of Total 
field from “TASKMAN”, this for all records of the “TASKMAN” table. 

But we can set a filter insteed of summing all records. This filter can be set on the 
Status for example. 

In our case we can link the “Status” field of the current record from “COSTS” table 
with the “Status” field of the “TASKMAN” table. 

Press the “Filter” Tab. 
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The filter syntax is the same as for the Filter/Color feature see below. 

Now the calculation will be done on each record and the filter will be applied on the 
Sum request according to the contains of the “Status” field from the “COSTS” table. 

So we can create 3 records in the “COSTS” table with a “Status” equal respectively 
to “Planned”, “In Progress” and “Complete”. 

 

We can notice that after the added records are not automatically updated. 

This is normal, in order to not slow down the application, the calculation update is 
manual. 

Open the main menu and select the “View” Pane. 

 

Press “CTRL+H” or choose “Calculate”. 
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All datas are now updated according to the filter and the Sum calculation. 
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2. Manage Windows 

2.1. Windows Navigation 

The SmallBase table display is splitted into 2 different part : the grid view and the 
card view. 

The display is entirely customizable. Each table stores its own preferences. 

Users can switch between the grid and the card views with the “TAB” key. 

“CTRL+TAB” is used to switch between displayed tables. 

 

2.2. Customize display 

The Card View can be removed separately for each kind of Table. 

The Grid font and the font size can be changed. 

The Zooming feature is applicable either on the card view or the grid view according 
to the focused window. 

Open the main menu and select “Preferences” in the “View” menu panel. 
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Display or Remove Card View, manage size, set or not the full screen mode, show 
grid lines or not. 

 

Select the font name, the size and the attributes. 

Hotkey is used to associate a Key to a Table. 

 

New if you press “T” or “t” on the keyboard, SmallBase will automatically switch to the 
“TASKMAN” table if already open or will open it. 

Card View display and Full Screen Mode are directly manageable with hotkeys. 

Press “CTRL+D” will remove Card View for the current table. 

Preferences are stored in the database for each table. 
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2.3. Resize Columns 

Users can use CTRL+SHIFT+ARROW to increase or decrease the width of the 
selected column. 

CTRL+RIGHT goes to the next column 

CTRL+LEFT goes to the previous column 

CTRL+SHIFT+RIGHT increases column width 

CTRL+SHIFT+LEFT decreases column width 

CTRL+UP and CTRL+DOWN change the sort order of the selected column. 
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3. Manage Records 

How to add records in the “TASKMAN” table. 

Press “Add” button to create a new record in the table. 

 

Enter datas with the dialog box. 

 

Available Buttons : 

Press Cancel to cancel the current entry 

Press OK to save the current entry 

Press Clear clean the current entry with a blank value 

Auto is a special button and allows different capabilities according to the field type : 

Field type Auto feature 
Date/Time Set the date or date/time to the current date/time 
Folders List Open the Folder browser and allow automatic selection of 

folders 
Files List Open the File manager browser and allow automatic selection 

of files. 
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Click “OK” to validate entry 

 

Edit an entry : select the item and press “Enter” key. 

 

In this case all labels are displayed, but users can decide to not display some of 
them. 

To do this, return in “Build” mode and change field settings. 

Let’s enter more records in order to continue with other powerfull features of 
SmallBase. 
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4. Copy, Cut and Paste 

Copy, cut and paste is supported by SmallBase. 

This feature is appliable on the same table or between table if the both tables have 
the same structure.  

Select more than on Record with SHIFT+UP or SHIFT+DOWN keys. 
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5. Manage Colors, Filters, Variables and Sorting Out 
Methods 

5.1. Manage Colors 

Cell or line colors can be choosen according to specific criterias. Each table can be 
color customizable and manages its own parameters. 

Colors are appliable on the fly. 

For example we can set a specific color for records which have a status=Planned. 

Open the main menu and select “Colors” in the “Table” menu, press “SHIFT SPACE 
BAR” to open the color selector. 

 

 

Users can now Add, Edit, Delete or Activate new Color settings. 

Add a Color criteria for records which have a status equal to planned. 

Press “Add” button. 
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Define a label to remember easily what kind of criteria has been defined. 

The criteria can be Active or Not at a time. 

Available fields with their labels are displayed for the current table in in a choice list 
and can be used in the clause condition. 

In our case, we enter : 

 

The request is very simple here, but SmallBase allows much more complicated for 
clause… 

What about the “Colors” Tab 
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By default, the color is applied on the whole line, but the color can also be applied on 
a specific cell corresponding to a column field. 

 

In this case we have selected the Cell corresponding to the “todo” column. 

Examples are just here as a reminder and can help users to understand what are the 
capabilities of SmallBase for criterias. 
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SmallBase allows complex combinaisons of fields into the clause condition. 

Clauses Explanations 
& This character represents a AND condition 
AND AND keyword is also supported 
| This character represents a OR condition 
OR OR keyword is also supported 
~ This character represents a LIKE condition 
LIKE LIKE keyword is also supported 
> Superior 
< Inferior 
<> Different from 
() Parenthesis allowed for complex formulas. 
R2>10 Field R2 must be greater than 10, R2 is of course a numeric or 

floating point field type 
R2=’TOT’ Field R2 must be exactly equal to ‘TOT’, R2 is of course a text-

based field. 
R2~’*TOT*’ 

Or R2 LIKE 
‘*TOT*’ 

Field R2 contains a sub-string equal to ‘TOT’, note that the ‘*’ 
character means that there can be characters on the left and of 
the right of the string. 

R2={20/07/2001} Field R2 is a Date field type and R2=20/07/2001. 

Note that a date must be enclosed into {} characters. 
R2={20/07/2001 
11:00} 

Note that the date can contain a time, in this case the format 
must be conformed to the date/time international settings on 
your device. 

R2={+2} Relative date can be defined here, in this case R2 is date and 
{+2} means Today+2days. So R2 = Today+2 days.  

{+0} means Today ! 

For Date/Time field types be aware to not use r2={+0} if you 
want r2=today for a such field , use r2>{-1} AND r2<{+1} insteed 
because, Date/Time field contains a time ! 

Negative values are allowed {-3}. 

The + and – signs are mandatory. 
R2={+02:50} Relative date from now. 

R2 must be a Date/Time field type and {+02:50} means now + 
2h and 50 mns. 

Negative values are allowed too. 
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The + and – signs are mandatory. 
R2=[01:44] R2 in this case is a duration field type. 

R2 = 01:44 

Note that durations must be enclosed into [] characters. 
R2=%var1% SmallBase allow filter which depends on variables. 

In this case the variable must contains a numeric or floting point 
string. 

Variables can be used for every kind of fields. 

See “Manage Variables” chapter in order to understand how 
variables can be created and updated. 

R2 LIKE 
‘*%project%*’ 

If project variable contains SB this can be replaced with R2 LIKE 
‘*SB*’. 

R2>3 AND 
(R4={+2} OR R5 
LIKE ‘*SB*’) 

This is complex condition which is completely supported by 
SmallBase. 

 

In our example we will have: 

 

Note that an activated Color setting is displayed with a (*) prefix. 

Users can see easily what kind of Color criterias are active at any time. 
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5.2. Manage Filters 

Filters are managed the same way as colors. 

Insteed of displaying data with a specific color, filters keeps in the view only records 
which match the active filters at a time. 

If more than one filter are activated at the same moment SmallBase will use a AND 
combinaison between all active filters criterias. 

The creation mode is the same as for the colors (see color chapter). 

In our example we will create a filter which display tasks in progress or planned. 

Use the main menu and select “Filter” in the “Table” menu pane or press “SPACE 
BAR” to open the Filter selector. 

 

 

Press “Add” button to add a new filter. 
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Note that the Color and Filter dialog boxes are the same. “Colors” Tab is grayed, 
because not available for filters. 
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5.3. Manage Variables 

SmallBase Filters and Colors criterias support variables. Variables must be enclosed 
into % characters. 

A variable is represented with a label and a value. There is no limitation for the 
number of variables but memory. 

A variable is a string of 255 chars max. A variable can contains anything. 

A variable can be a numeric, a floating point, even a date … 

Actually, variables are stored into the database as entered, no check is done after 
entering the value. 

Variables are very useful, because they make filters and colors become dynamic. 

Variable must be created manually. Variables are available for all Tables in the same 
database. 

Use the main menu and select “Variables” in the “Table” menu pane. 

 

At the first time SmallBase will open the dialog box below in order to enter the name 
of the first variable. 

 

We can choose the new name “project” for this variable. 
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Press “OK” to validate variable creation. 

 

The new dialog box allows now variables updates, creation (“Add”) or deletion 
(“Delete”). 

To create a new variable, press “Add” 

 

Press “OK” 
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Enter a value for “Project” 

 

Press “OK” 

Create a new filter which will use this variable in order to display value according the 
“project” variable value. 
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Let’s see the result ! 

 

 

If we now change the value of project to enter “POCKET” insteed of “SB” 
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Press “OK” and let’s see the result. 

 

A new record has been selected ! 

Important Note : Filters and Colors criterias using unknown or empty variables are 
automatically ignored by SmallBase ! 

Variables may be used in the “Variable” field types, see below. 
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5.4.How to use a Variable field Type ? 

A variable type field is used to allow user set different variable value to a field in a 
record. This is very useful when you have to use this field in calculations. A typical 
case consists in managing a Currency conversion Table. 

Let’s create a Table which contains : 

Currency Text type field (10 chars) , the name of the currency 

Exchange 
Rate 

Floating point type field, The exchange rate for the currency in 
your money 

Value A Variable type field which will contains for example the Variable 
“Amount” 

Total A Formula type field which contains this : r3*r4 (Exchange 
Rate*Value) 

 

 

 

Let’s define the vari able “Amount” 

 



SmallBase User Manual 

37 

 

 

We have entered 120 as example. 

So how to use this new conversion table. 

We can add a record into the Currency table. It can be the reference 
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Of course 120*1 =120 

Let’s see now EUROS in USD with an exchange rate to 1.13 and add it to our 
Currency Table. 

 

Of course the Value is always “Amount” 

 

Now we can mask the column Value by editing it and set  Visible to No. 
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So how to use the conversion table.  

It’s very easy you just have to edit the Variable Value in pressing “CTRL+W” 

And set the new value to 200 for example 

 

 

The display isn’t automatically updated but if you press now “CTRL+H” or do a 
Calculate from the main menu. 
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The display is now refreshed with the right values. 

You have create a small application to manage Currency Conversion. 
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5.5. Manage Sorting Out Methods and Increase Speed 

Sorting out methods let’s the user sort datas in table according to one or more 
criterias.  

Let’s take previous example and set a sorting out method on the Currency Name 

 

Open the main menu and select “Sort By” 

 

Sorting out methods are managed the same way as Filters and Colors. 

 

We can add a new method called “Currency”. 

We have selected the Currency Name field and we have choosen to sort datas 
ascendingly. 
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Actually, we can define more than one criteria and create sofisticated indexes.  

The fields must be separated with a comma and must have a keyword “ASC” for 
ascending sort or “DESC” for descending sort. 

Every kind of fields can be used in the sorting out methods. 

BE AWARE : Sorting out methods generate indexes into the database, these 
indexes can be very large if you create indexes on long string. We not recommend to 
create indexes on text field with more than 50 chars. 

A database with lot indexes may take time on compaction or on repair. 

 

The sorting out method must now be activated to be available. 

Press “ACTIVATE” do set it as the default sorting out method. 

 

Now the datas are sorted according to the Currency name. 

You can increased data search in selecting the right index according to what you are 
searching. 

Example: We have a dictionnary table composed with a “word” and its “translation”. 
It’s a good thing to add a sorting method on the “Word” field. When you’re looking for 
a word. SmallBase might find it 10 times faster. 
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We can also create a sorting out method on the Total and sort datas according to the 
total descending. 

 

 

Activate the new sorting out method, Note that only ONE method can be used at the 
same time. For combinaison with more than one field, create more than one Sorting 
Out methods 
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. 
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5.6. Manage Filters and Colors with Table Links 

Another great feature of SmallBase consists in creating Filters and Colors criterias 
which support fields from others tables. 

The previous example can become totally dynamic in using a table which contains 
Project ids. 

Let’s create a new table “Projects” which contain 2 text fields Project and Customer. 

 

 

Open table Projects and enter 2 projects “SB” and “PocketIQ” 

 

We will now open the “TASKMAN” table and create a filter which refer the “Projects” 
Table. 
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Note that as for variables, the reference to the “Projects” table fields must be 
enclosed into “%” chars. 

We can create different kind of link and mix more than one table in the criteria. 

To help users remember valid fields in current database Tables, a choice-list has 
been added to select the table, so available fields choice-list is updated according to 
selected table. 

How SmallBase deal with this ? 

In fact, to use a such filter you must open all referred tables in the criteria. In our 
case, open the “TASKMAN” table and the “Projects” table. As for variables, if 
referred tables are not opened,  criterias are ignored by SmallBase.  

The “TASKMAN” table view will be updated according to the “Projects” table view. If 
you select an item in the “Projects” table view the field “r2” (Project) will contain a 
certain value. When you switch to the “TASKMAN” table view, the active filter will be 
updated with this new value and the filter will be applied on the view. 

Let’s see this with an example. 

Activate only this new filter. 

 

Select an item in the “Projects” table view. 
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Now the selected project is “SB” 

Let’s see the result when return to the “TASKMAN” table view. 

 

We can check that only record which refers “SB” in project field are displayed ! 

Let’s return to “Projects” table view and select another project. 

 

We return again in the “TASKMAN” table view. 
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Now records which contains “POCKETIQ” project are displayed ! 

This feature works also with Colors. 
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6. Search 

SmallBase offers an extended search feature. 

Use the main menu or press directly the “Find” button. 

 

 

Search feature is working 2 ways : 

Classical search : SmallBase goes on the first matching row 

Extended search : SmallBase filter datas and display only matching rows. In this 
case this new filter is added to the active ones. 

SmallBase can perform the search on all fields or on a specific field. SmallBase 
can search data from the current row forward or backward. The search can be case 
sensitive. Search can be done on a substring or on the exact word. 
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For classical search, SmallBase will locate the next row matching the condition in 
pressing “Next” in the main menu or CTRL+J. 
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7. Manage Files and Databases 

7.1. Open and Create Databases 

SmallBase can manage more than one table in one database but only one file at 
once. 

For this reason file selection has been improved to make it much easier. 

Open or create new SmallBase databases with only one dialog box. 

Press “File” button or use the main menu and select “Open” in the “File” menu pane. 

 

SmallBase stores the recents files in a choice list, so the database selection is really 
easy. 

Users can remove a file from the history list by pressing the “BACKSPACE” key. 

The “New” button allows the creation of a new database. 

Navigate through the file manager and open a SmallBase file with the 
“Browse”Button. The selected file will be automatically added to the history list. The 
database can be easily reopened. 
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7.2. Compact and Repair databases 

SmallBase databases can be compacted at any time. After lot of updates, it’s 
recommended to do a compaction of the database in order to reduce the size of the 
file. This is valuable for ER3 and ER5 devices. EPOC DBMS has been more 
optimized in ER6, this operation is not always required but recommended. 

Use the main menu and select “Compact”  

 

To repair a database choose Repair insteed of Compact. When repainring a 
database, SmallBase does first a destroy of all existing indexes on the tables, a 
recover of the database after a damage check, and a reindexation of the database 
according to the permanent indexed fields. 

Use the main menu and select “Repair”  
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8. Protect Databases 

A really great feature of SmallBase consists in protection of your confidential datas. 

SmallBase integrates a powerful encryption engine. This encryption engine is based 
on the popular “Encrypt-it” software for EPOC devices from Peter Csutora. 

SmallBase use a 256-bits encryption key, based on user-defined password. 

Users can use the same password for all databases, the file encryption will be 
different each time. 

Without the right password for a protected database, the datas are definitively lost. 

Encryption is automatically applied on the file after closing the database or when 
SmallBase goes background. 

When SmallBase regains the focus, SmallBase will ask for the requested password, 
will decrypt the file and will finally reopen the database. Without the password, the 
database can’t be reopen. 

Users must take in account the encryption calculation delay depends on the EPOC 
device when using this feature for opening a database. It is recommended to activate 
this feature on small databases. 
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The file is now password protected. 

Switch to another task. 

 

Come back to SmallBase 

 

 

To cancel a password, users must set the password again and just press “Enter” 
key, the old password will be removed. 
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9. Active fields and Automation 

9.1. Making a phone call 

Telephone number field type from SmallBase allows user to make directly a phone 
call from the device. 

For ER3 and ER5, SmallBase will generate DTMF frequencies. 

For ER6 (Nokia 9210/9290), SmallBase will automatically make a call for the selected 
record. 

If there is more than one telephone number field in the record, SmallBase will open a 
list box with all telephone numbers. Users can select one of them and press 
“Compose” to issue the call. 
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9.2. Start a document or an application from SmallBase 

The “File List” field type can be used to start documents or applications directly from 
SmallBase. 

SmallBase can easily become a document launcher. 

Let’s go and create a File Launcher with SmallBase 

Turn SmallBase into “Build” Mode and create a new table 

 

Add fields : Label (Text) and File (File List). 

 

Close the selector and return to normal mode 
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Select the new table. 

 

Create some records and remove the card view just to see the File names. 

 

We have created a shortcut to CALC application and a shortcut to two JPEG 
documents. 

Note that build in application are located in the ROM so in Z: drive. 

Let’s start the CALC, select the CALC record and press CTRL+G 

 

Close the calc, then you’ll return immediately to SmallBase. 
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When there is more than one document in the “File List” field. SmallBase opens a list 
box which contains the files. 

 

Select one and press “OK”. 

 



SmallBase User Manual 

59 

9.3. Manage Folders 

The “Folder List” field type can be used to manage your preferred folders. 

SmallBase allows users to define field which can contain folders. SmallBase will open 
a browser view on the path and let’s users start files from it. 

Add a new “Folder List” field type in the “START” table, and enter a path. 

 

In this case, we have edit an entry and set the “Folder” field to the path 
“C:\documents\”. 

Click “OK” to confirm update. 
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Open the main menu or press “CTRL+B” to open SmallBase file browser. 

 

Browse the folder or select a file and start it by pressing the “ENTER” key. 

Let’s start “sheet” ! 

 

Quit Sheet application and we return directly to SmallBase. 
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9.4. Quick Calculations 

Quick Calculations is another useful feature of SmallBase. Quick Calculations 
allows users to do fast sum, min or max calculation on a selection or on the entire 
view. 

SmallBase will select all numeric and floating point fields in the table and will 
calculate the fields sum for the selection or for the entire view. 

 

Open the main menu or press “CTRL+U” 

 

Press “OK” after having selected “All” 

 

The result is displayed in the card view. 
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9.5. Set Alarms on items 

An alarm management feature has been added into SmallBase. 

Users can now create alarms on each records of the displayed view. 

The alarms are available ONLY if SmallBase is running. 

Important Note : alarms are disactivated on a password protected database when 
SmallBase goes to the foreground (the database is closed and encrypted). 

Alarms wakes up your device even if this one is not powered on. 

SmallBase use the default agenda alarm for Nokia ER6 based devices (9210/9290) 
but can be selected on ER3/ER5-based devices. 

 

Set an alarm on the selected record. 

 

Use the main menu or press “SHIFT+CTRL+N” 
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Validate the alarm date and time. Select also sound for ER3/ER5 devices. 

 

Note the small rect added to the left of the record, this means that the record has an 
alarm positionned. 

For the example we can switch to another table. 

 

For this example, press “Extra” or “System” button to make SmallBase goes 
foreground. You can also turn your device off. 
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SmallBase wakes the device up and bring SmallBase to foreground. 

 

The alarm sound will be played 5 times with a pause of 30 secs between each. 

Press “OK” to stop the alarm and close the dialog box. 

 

SmallBase has automatically open the concerned table and has located the cursor 
on the record. 
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10. Printing and Report 

The printing feature is really simple, SmallBase can print what is displayed in the 
Card View. 

So users can print the current record, a Quick Sum calculation or a Report. 

 

Users can change page setup before print. 

How to generate a report ? 

Open the main menu and select Report. 

 

A report can be done on the current view or on a selection. 
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Press ”OK” to validate. 

 

The report has been generated in the card view. 

All selected lines has been included in the report. Users can now print it with the main 
menu. 

Note that the last line contains for each numeric field the sum of the all records. 

Users can see the report in details with the “TAB” key. 
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11. Extra Linking Feature 

SmallBase offers an extended linking feature. The extra linking feature allows users 
to create free links between items into the same table or between different kind of 
tables. 

This feature must be used onto small tables because the display can become slow if 
there is too much records in a table. 

Let’s see this with an example. 

We will create a link on a record from “Projects” table and a record from “START” 
table.  

Open the “Projects” table and select an item. 

 

We want to link this record with another record from the “START” table. 

Start the link creation in using the main menu or press “CTRL+L” 
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Ok now, select the “START” table in order to select the linked item. 

 

Select the record and open the main menu and select “Apply Link” or press 
“SHIFT+CTRL+L” to complete the link. 

 

Note that you can cancel a link in progress in pressing “Cancel Link” 
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Now the link is established between the both records. 

So what’s the use of this ? 

In fact, users now can turn SmallBase into “Link mode” 

If you want to retrieve all records from other tables which are linked to the current 
item. Select the current item and press “CTRL+Y” 

 

The current table contains only records which are linked to the selected one. The 
current selected record is displayed with a “[*]”. 

In this table no more linked items are found. 

Open the “START” table to see if the linked items are also displayed. 
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We retrieve the current linked item displayed. 

To come back SmallBase “Normal Mode”, users can press “SHIFT+ CTRL+Y” or 
select again the selected item. 

 

SmallBase has returned “Normal Mode” 
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12. Export and Import 

12.1. Import 

Users can import datas into SmallBase from text files CSV or from FoxPro, DBASE 
III,IV, IV files. Users can also import tables from Power Data, ProjXpert, DCP, 
Business Warrior, OPL applications, and some of other EPOC applications. 

Users can also import tables from other SmallBase files with the “Merge” item menu. 

 

Before importing from CSV (Comma separated value) files, users must create the 
database structure and datas must be in accordance with the table and fields format. 

It’s recommended to add some test datas in the table and do a CSV export to 
understand what’s the expected input format. 

For CSV format, strings must be enclosed into “” characters. 

Users can’t have to create table structure when importing from DBASE files. The 
table structure will be automatically generated by SmallBase. 

 

12.2. Export 

Users can also export datas from SmallBase into text files. The files can be CSV or 
HTML. 
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Another useful feature of SmallBase consists in exporting the card view. Users can 
easily export the current record, a Quick Sum calculation or a report into a text file. 

 


